
CROPWAT PARA WINDOWS 
 

Preparado por Ricardo Trezza 
 
 

Introducción 
 

CROPWAT (crop = cultivo; wat = agua)  es un programa que utiliza el método de la 
FAO Penman-Monteith para determinar la evapotranspiración de los cultivos (ET).  Los 
valores de ET son utilizados posteriormente para estimar los requerimientos de agua de los 
cultivos y el calendario de riego. El programa CROPWAT puede ser descargado de la siguiente 
dirección:  http://www.fao.org/ag/AGL/AGLW/cropwat.stm (versión para Windows). 
 
 
PARTES DEL CROPWAT 
 

El ambiente de trabajo del CROPWAT esta definido de la siguiente manera: 
 

 
 

(1) Es el menú principal 
(2) Barra de herramientas 
(3) Caja de mensajes, para informar acerca de los cálculos que se están realizando 
(4) Estado de los datos, para informar acerca de los archivos utilizados 

 
1.  Menú Principal 
 

 
 
- Primero se introducen los datos (utilizando File o InputData) 
- Luego se define los criterios para el calendario de riego (Shedule > Criteria) 
- Los resultados pueden observarse en tablas o gráficos (Tables o Graphs) 
- Los resultados pueden salvarse como archivos de texto para imprimir (SaveReport) 
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2.  Barra De Herramientas 
 
 

 
 
 
 

3.  Ventada de Estado de los Datos 
 

Al activarla (InputData > Data Status), nos da información sobre los 
archivos ejecutados y los cálculos que pueden realizarse: 
 
 
 
 

 
 
 
 
 Tipos de Archivos Manejados por CROPWAT 
 
*.PEN, *.PEM   archivos de datos climáticos  ;  *.CLI, *.CRM   datos de lluvia 
*.CRO   archivos con coeficientes de cultivo ;  *.CPT  patrón de cultivo 
*.SOI ,  *.SOL   archivos con datos de suelo 
*.SNR  escenarios de riego ;  *.IRR  riegos  ,  *. ADJ  ajustes del usuario 
*.TXT  archivos de texto con resultados para imprimir 
 
Los archivos son almacenados en directorios (que pueden ser cambiados a conveniencia): 
Options > Default File Locations 
 
 

 2



 
 
 
 

Descripción del Menú “File” 
 

 
 
 
 
Menú de Entrada de datos (Input Data) 
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El Menú para el Calendario de Riego (Schedule)  
 
 

 
 
 
 
Descripción de los criterios 
 
Al hacer Schedule > Criteria  aparecen la ventana Calculation Methods. Si hacemos clic en 
el tabulador Scheduling tendremos las siguientes opciones: 
 
 

 
 
Esta ventana es de suma importancia porque es el lugar donde vamos a definir cuando, como y 
cuanto regar (momento, frecuencia y láminas de riego).  A continuación se dará una 
descripción de cada uno de los criterios disponibles.  
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1. TIEMPO DE APLICACION DEL RIEGO (APPLICATION TIMING) 
 
Las opciones son las siguientes: 
 

 
 
 
a)  Irrigated When a Specified % of Readily Soil Moisture Depletion Occurs:  Regar 
cuando se ha agotado un porcentaje de la lámina fácilmente aprovechable por las plantas 
(lámina neta, Ln), calculada como: 
 
 

URPrDa
100

PMPCCLn ∗∗∗
−

=  

 
donde Ln = lámina neta o agua fácilmente aprovechable por las plantas (mm); CC = capacidad 
de campo (%); PMP = punto de marchitez permanente (%); Da = densidad aparente (gr/cm3);      
Pr = profundidad radicular (mm) ; UR = umbral de riego (fracción). 
 
 
Si se coloca 100 % (ver figura abajo) significa que vamos a regar cuando se agote un 100% del 
agua fácilmente aprovechable, lo que asegura que el cultivo no sufrirá por estrés hídrico. 
 
 

 
  
 
 
b) Irrigated When a Specified % of Total Soil Moisture Depletion Occurs:  Regar cuando 
se ha agotado un porcentaje de la lámina almacenable (La). La lámina almacenable se define 
como: 
 

PrDa
100

PMPCCLa ∗∗
−

=  

 
Si se selecciona esta opción deberá colocarse el umbral de riego en %, colocando 100 % si se 
desea evitar situaciones de estrés hídrico para el cultivo.  
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c) Irrigated When a Specified Soil Moisture Depletion Occurs:  Regar cuando se ha agotado 
una determinada lámina del agua del suelo (en milímetros). Útil cuando se va a utilizar una 
lamina de riego constante en cada riego, no importando el intervalo de tiempo entre los riegos. 
 
d) Irrigated at Fixed Intervals (Days): Regar considerando una frecuencia (intervalo) de 
riego  fija (días). Esta opción es bastante utilizada para facilitar la operación del riego.  
 
e) Irrigated at Variable Intervals – User Defined (Days): Regar considerando una frecuencia 
(intervalo) de riego  variable, definida por el usuario (días). 
 
 
2. LÁMINA DE RIEGO (APPLICATION DEPTHS) 
 

Tenemos las siguientes opciones: 
 

 

 
 

 
 
a)  Refill to a Specified % of Readily Available Soil Moisture: Aplicar riego hasta lograr un 
porcentaje determinado de la lámina de agua fácilmente disponible (Ln). 
 
Si se coloca 100 % (ver figura abajo) estamos llevando la humedad del suelo a capacidad de 
campo: 
 
 

 
 
 
b) Fixed Depths (mm):  Aplicar riego utilizando una lámina constante en cada riego (mm) 
 
c) Variable Depths (User defined) (mm): Aplicar las láminas de riego según especificaciones 
del usuario.     
 
 
3.  COMIENZO DEL CALENDARIO: 
 

Tenemos las siguientes opciones: 
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a) First Planning Date of Each Crop: comenzar el calendario de riego el dia de siembra de 
cada cultivo. 
 
b) Specified Date:   comenzar el calendario de riego en una fecha cualquiera. 
 
 
 

MENU DE TABLAS Y GRAFICOS 
 
 Los resultados obtenidos a través del CROPWAT pueden ser presentados en forma de 
tablas o gráficos utilizando el Menú Principal o los Íconos de la barra de herramientas:  
 
 

 
 
 
 

 
 
 
También se pueden utilizar los íconos de la barra de herramientas del CROPWAT para acceder 
a las tablas y gráficos: 
 

 7



 

 
 
 
Tabla de datos Climaticos 
 
Haciendo clic en Tables > Climate & ETo (menú principal) o en el ícono correspondiente en 
la barra de herramientas (el termómetro) aparece la tabla que muestra los datos de lluvia:   
 
 

 
 

 
Country = País; Station = estacion; Altitude = altitud; Month = Mes;   Max. Temp. = 
Temperatura Máxima; Min. Temp. = Temperatura Mínima;  Humidity = humedad relativa del 
aire; WindSpeed = velocidad del viento;   Sunshine = insolación; Solar Radiation = 
Radiación Solar. 
 
Una copia de la tabla puede ser guardada como archivo de texto haciendo clic en el botón 
“Report” y asignándole un nombre. El archivo guardado puede ser visto o mandado a imprimir 
seleccionando File > TextEditor, o abriéndolo utilizando el programa Word.  
 
 
Ejemplo de Tabla de datos de Lluvia 
 
Haciendo clic en Tables > Rainfall (menú principal) o en el ícono correspondiente en la barra 
de herramientas (nubecita con lluvia) aparece la tabla que muestra los datos de lluvia:   
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La tabla muestra la lluvia total (registrada por la estación) y la lluvia efectiva (Effective), la 
cual es calculada por CROPWAT según algún criterio de calculo.  Los criterios de calculo 
aparecen dando clic en el botón “Effective”.  Aparecerá una ventana que permite seleccionar el 
criterio a utilizar (active el tabulador Effective Rain):      
 
 

 
 
 
 
Ejemplo de Grafico de Clima 
 
Los gráficos pueden ser observados hacienda clic en Graphs > Climate en el menú principal o 
hacienda clic en el ícono correspondiente en la barra de herramientas: 
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El grafico muestra la temperatura media para cada mes (barras) y las líneas muestran las 
temperaturas máximas y mínimas. Se puede imprimir el grafico haciendo clic en el botón 
“Print”. Asimismo podemos activar los gráficos de humedad relativa (Air Humidity), 
velocidad del viento (Wind Speed) , insolación (Daily Sunshine) y ETo.  
 
Cuando hacemos clic en el botón “Print” aparecen una serie de opciones que permiten 
controlar la impresión: 
 
 

 
 
 
 
 
Ejemplo de Tabla de requerimiento de agua de los cultivos (CWR) 
 
Haciendo clic en Tables > CWR (menú principal) o en el ícono correspondiente en la barra de 
herramientas aparece la tabla que muestra los datos de requerimiento de agua de los cultivos :   
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En la Tabla aparece el cultivo (MAIZE (Grain) = Maíz en grano), el bloque seleccionado (All 
blocks); el intervalo de tiempo para la presentación de la información Time Step (Days (por 
defecto es de 10 días, pero puede ser cambiado), la eficiencia de aplicación del sistema de riego 
Irrigation Efficiency (por defecto el programa toma 70% pero puede ser cambiado según el 
método de riego). 
 
Las columnas muestran: 
 
Date: fechas de presentación de la información 
 
ETo:  ETo  en mm/periodo (si el periodo es de 10 días es el total de ETo ocurrido en los diez 
días) 
 
Crop Area:  área destinada para el cultivo seleccionado, en porcentaje del área total. En este 
caso el maíz ocupa el 100% del área total (no hay otro cultivo). 
 
Crop Kc:  coeficiente promedio del cultivo seleccionado para el período indicado. 
 
CWR: requerimiento (neto) de agua del cultivo en mm/periodo. Por ejemplo el valor de 22.07 
significa que se requieren de 22,07 mm para satisfacer la demanda de agua del cultivo en los 
primeros diez días.  Se calcula como CWR=ETc = ETo * Kc 
 
Total Rain: lluvia total ocurrida durante el periodo.  
Effective Rain:   lluvia efectiva ocurrida durante el periodo. 
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Irrig. Req.:  Requerimiento (neto) de riego para el periodo considerado (considerando la 
lluvia). Por ejemplo el valor de 19,67 significa que se necesita aplicar una lámina de riego de 
19,7 mm para satisfacer la demanda de agua de los cultivos durante el periodo (en este caso 
diez días).  Irrig. Req: = CWR – Effective Rain  
 
FWS: (Field Water Supply): cantidad de agua que se necesita para satisfacer la demanda de 
agua de los cultivos, en litros/segundo/hectárea (caudal módulo). El primer valor 0,33 significa 
que debemos disponer de 0,33 l/s para satisfacer los requerimientos de agua de cada hectárea 
sembrada por el cultivo (en este caso maíz). Este valor considera la eficiencia de riego. 
 

3600*24*ays)TimeStep(d*0)iciency/10(Irrig.Eff

10000*Irrig.Req
FWS =  

 
En la línea final de totales (Totals)  el valor entre corchetes muestra el requerimiento promedio 
de agua. En nuestro caso el valor de [0.72] significa que necesitamos 0,72 l/s por cada hectárea 
para atender la temporada de crecimiento del  cultivo. 
 
Haciendo clic en el botón “ Report” permite salvar la tabla como archivo de texto. 
Posteriormente se puede abrir e imprimir el archivo usando un programa como el Word o el 
mismo editor del CROPWAT (ícono del cuadernito).  
 
 
 
Ejemplo de Tabla de Calendario de Riego (Irrigation Scheduling) 
 
Haciendo clic en Tables > IrrigationSchedule (menú principal) o en el ícono correspondiente 
en la barra de herramientas, aparece la tabla que muestra los datos del calendario de riego:   
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La tabla muestra el cultivo (MAIZE (Grain)); el numero de bloque (Block # 1); la opción 
seleccionada:  Calendario de Riego (Irrigation Schedule) o Balance diario de la humedad en el 
suelo (Daily Soil Moisture Balance). 
 
Un dato importante a considerar es la reducción esperada de la cosecha (Yield Reduction).  
Nuestro objetivo es que no se produzca reducción en la producción (0.0%). Esta reducción en 
la producción es debida al posible estrés hídrico a que nuestro cultivo pudiera estar sometido 
según los criterios asumidos cuando definimos los criterios del calendario de riego (esto es 
láminas, frecuencias y tiempo) introducidos en  Schedule>Criteria.  Si la reducción en la 
producción es inaceptable debemos cambiar algún criterio de riego. 
 
Las columnas muestran lo siguiente: 
 
Date: fechas de presentación de la información.  
 
TAM: total de agua almacenable por el suelo hasta la profundidad radicular del cultivo para la 
fecha indicada (La). 
 
RAM: agua fácilmente disponible para el cultivo (lámina neta, Ln). 
 
Rainfall (mm): cantidad de lluvia para la fecha indicada (CROPWAT asume 5 eventos de 
lluvia por mes). 
 
Efect. Rain (mm).  Lluvia efectiva, cantidad de agua que entra a la zona radicular. 
 
ETc : evapotranspiración del cultivo. 
 
ETc/ETm: Debe ser 100 % para que el cultivo no sufra por estrés hídrico. 
 
SMD: Soil Moisture Deficit.  Agotamiento (déficit) de la humedad total del suelo para la fecha 
indicada.  Lámina que se debe aplicar para llevar el suelo a capacidad de campo. 
 
Irr. Interval.  Intervalo de riego en días desde que se produjo el ultimo riego.   
 
Net.Irrig.  Muestra los días donde se requiere el riego y las laminas netas a aplicar. Los días de 
riego son aquellos donde existe un Net.Irrig. > 0.  En el caso de riego en función del 
agotamiento, el riego se produce cuando la lámina agotada supera el umbral de riego. En el 
caso de frecuencia (intervalo) de riego fija, depende del numero de días entre riegos. 
 
Lost. Irrig. Pérdida del agua aplicada por el riego, debido a la percolación profunda. 
 
User adjust: Opción que permite al usuario hacer ajustes al calendario. 
 
Haciendo clic en el botón “ Report” permite salvar la tabla como archivo de texto. 
Posteriormente se puede abrir e imprimir el archivo usando un programa como el Word o el 
mismo editor del CROPWAT (icono del cuadernito).  
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Grafico del Calendario de Riego 
 
Haciendo clic en Graphs > IrrigationSchedule (menú principal) o en el ícono correspondiente 
en la barra de herramientas aparece el gráfico que muestra los datos del calendario de riego:   
 
 

 
 
 
El grafico muestra el cultivo (MAIZE), el bloque (Block # 1) y las siguientes curvas: 
 
Lost Irrigation: Muestra la lámina aplicada de riego que se perdió por percolación. 
 
SMD: Muestra el cambio del agotamiento de humedad del suelo. Cuando es igual a 0 significa 
que el suelo se encuentra en capacidad de campo. Esta línea no debe superar a la línea 
correspondiente al RAM para evitar situaciones de estrés hídrico. 
 
RAM: línea que muestra el agua fácilmente aprovechable (Ln), en función de la profundidad 
radicular del cultivo. Esta curva muestra indica el agotamiento máximo de humedad que se 
puede permitir para evitar condiciones de estrés hídrico en el cultivo. 
 
TAM: curva que muestra la lámina total que el suelo puede almacenar hasta la profundidad 
radicular (Lámina almacenable, La). 
 
La situación mostrada en la Figura anterior es la deseable cuando planifiquemos el riego, donde 
vemos que el agotamiento de agua en el suelo (SMD) no supera al valor del agua fácilmente 
aprovechable (RAM).  
 
En la Figura de abajo podemos ver que situación debemos evitar: 
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En este caso SMD > RAM en muchas situaciones, lo que generara estrés hídrico en el cultivo y 
la consiguiente perdida de cosecha. 
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ENTRADA DE DATOS AL PROGRAMA CROPWAT 
 
 Para ilustrar la forma en que se introducen la información al programa CROPWAT 
desarrollaremos un ejemplo donde calcularemos los requerimientos de riego para un cultivo de 
caraotas negras (frijoles secos) a sembrarse en un área de Coro, Estado Falcón.  
 
 Los datos de la estación meteorológica son los siguientes: 
 
 
                                       País: Venezuela                  Estación : Coro 
                                      Altitud: 16 msnm 
                                      Latitud: 11.25 oN         Longitud: 69.41 oO 
                      ---------------------------------------------------------------------------------- 
                       Mes     Temp. Max    Temp. Min   HR     U2            n              Prec. 
                                          (oC)           (o C)             (%)   (Km/d)    (horas)      (mm) 
                    ----------------------------------------------------------------------------------- 

Ene             31.0            21.0        76.0       199.0       7.6              47.0  
Feb             31.2            21.2        73.0       242.0       8.0              25.0 
Mar            31.7            21.7        67.0       242.0       9.1                8.0 
Abr             32.7            22.7        83.0       251.0       7.1              12.0  
May            33.4           23.4         78.0      156.0        8.0              38.0 
Jun             33.6            23.6         74.0      156.0        8.7              22.0 
Jul              33.3            23.3         70.0      164.0        9.2              31.0 
Ago            33.7            23.7         69.0      156.0        9.1              38.0 
Sept            34.0            24.0         79.0      138.0        7.6              54.0 
Oct             33.4            23.4         79.0      130.0        7.4              69.0 
Nov            32.6            22.6         81.0      147.0        7.0              49.0 
Dic             31.4            21.4         78.0      164.0        7.3              60.0 

 
 
Datos del Suelo  
Textura del Suelo: Franco 
CC = 24 %. ;  PMP =13 %  ; Da = 1.3 gr/cm3 
Tasa de infiltración del suelo: 40 mm/día 
 
Datos del Cultivo 
Nombre del cultivo: caraota 
Día de siembra: 20 de Abril   
Longitud de las etapas de desarrollo: 25 días (etapa inicial), 35 (desarrollo), 40 (int.); 20 (final). 
Coeficientes de cultivo:     0.42 (etapa inicial), 1.15 (intermedia); 0.35 (final).       
Máxima profundidad radicular = 70 cm 
Umbral de riego recomendado para todas las etapas = 0.45 (45 %)   
 
Riego 
Eficiencia del sistema de riego: 70% 
Se piensa regar con una frecuencia de 7 días 
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ENTRADA DE DATOS AL PROGRAMA CROPWAT 
 
1. Datos Climáticos 
 
En el menú principal seleccionamos InputData > Climate > Enter/Modify.  Se abre la 
ventana de entrada de datos climáticos mensuales (Monthly Climate Data). 
 
 

 
 
 
Vamos a introducir todos los datos comenzando con el mes de Enero. En realidad, en nuestro 
caso, debido a que el cultivo va  a ser sembrado en Abril, podemos empezar a introducir datos 
desde el mes de Abril y hasta el mes de Agosto que es donde se realizara la cosecha. Sin 
embargo y a manera de ejercicio, introduzcamos todos los meses del año. Por ejemplo para el 
mes de Enero tenemos:  
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Como puede verse en la figura anterior, los datos de ETo son calculados al darle clic al botón 
“Calculate ETo”. 
 
Al terminar Enero daremos clic a “Next” y podremos introducir el próximo mes Febrero y así 
sucesivamente hasta llegar a Diciembre. Al finalizar de introducir los datos dar clic al botón 
“Save” y darle un nombre al archivo de datos climáticos (coro.pem) 
 
 

 
 
 
2. Datos de ETo 
 
Los valores de ETo calculados anteriormente se pueden observar al seleccionar  InputData > 
ETo > Enter/Modify. Aparecen los datos calculados previamente. Salvemos estos datos en un 
archivo presionando el botón “Save”. Como nombre usemos coro.pmm  
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3. Datos de lluvia 
 
El próximo paso consiste en introducir los datos de lluvia. En el menú principal seleccionamos 
InputData > Rainfall > Enter/Modify.  Se abre la ventana de entrada de datos climáticos 
mensuales (Monthly Rainfall Data). 
 
Se introducen los datos de precipitación total mes por mes, comenzando de Enero. La 
precipitación efectiva es calculada automáticamente por el CROPWAT utilizando el metodo 
considerado por defecto. Salvemos estos datos en un archivo presionando el botón “Save”. 
Como nombre usemos coro.crm 
 
 

 
 
 
Si se quiere cambiar el método de calculo de la precipitación efectiva darle clic al botón 
“Effective” de la ventana de “Monthly Rainfall Data” . Con lo que se abrira otra ventana 
mostrando los distintos métodos de calculo de la precipitación efectiva. Por defecto 
CROPWAT tiene activado el método del Servicio de Conservación de Suelos de los Estados 
Unidos (USDA Soil Conservation Service Method). Otro método útil es el primero “Fixed 
Percentage” donde si colocamos por ejemplo 80 entonces tomara el 80% de la precipitación 
total como la precipitación efectiva. Si no queremos considerar la precipitación (por seguridad 
en el calendario de riego) podemos colocar un porcentaje cercano a 0.   
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4. Datos del cultivo 
 
Los datos del cultivo se introducen en dos pasos.  
 
a) Primero se introducen los datos del patrón del cultivo seleccionando  InputData > Crops > 

Cropping Pattern > Enter/Modify 
 
 

 

 
Se abre la ventana  
 

 
 
 
Crop : cultivo ;  Kc values : valores de Kc correspondientes a la etapa inicial, intermedia y 
final;  Planting Day/Month: Día y Mes de siembra;  
 
Stage Days: Longitud de las etapas de desarrollo del cultivo (inicial, desarrollo, intermedia, 
final);  Root Depth: Profundidad radicular (valor inicial ≅ 0,25 – 0,30 m y valor final = 
profundidad máxima que alcanzan las raíces del cultivo)  
Depletion: umbral de riego para las etapas inicial, intermedia y final;  
Ky Values: valores de Ky para las cuatro etapas de desarrollo del cultivo.      
 
Una buena manera de llenar esta tabla cuando no se tiene alguna información (por ejemplo los 
valores de Ky) es de darle clic a “Retrieve” y buscar en la biblioteca del CROPWAT el cultivo 
a utilizar (o uno similar). En nuestro caso buscamos el archive de “Beans Dry” que es el más 
aproximado a las caraotas negras.     
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Posteriormente cambiamos el archivo modelo introduciendo nuestra información particular. Por 
ejemplo  Crop = caraota; Kc inicial = 0.42;  Longitud etapa inicial = 25 dias; Longitud etapa de 
desarrollo = 35 dias; Depletion (umbral) = 0.45 para todas las etapas.  
 
 

 
 
 
Finalmente damos clic en “Save” y salvamos el archivo como caraota.cro. 
 
 
b) Posteriormente se introducen los datos del patrón del cultivo seleccionando  InputData > 

Crops > Cropping Pattern > Enter/Modify 
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Se abrira la siguiente ventana:  
 

 
 
 

Crop No. : número del cultivo; Crop Data File: nombre del archivo que tiene los datos del 
cultivo (con el botón Browse se puede buscar el archivo). En nuestro caso debemos introducir 
aquí al archivo creado en el primer paso caraota.cro ;  
 
First Planting Day/Month : Día y Mes de la primera siembra;  First Harvesting: Primera 
cosecha; Percentage of Total Area Planted to Crop: porcentaje del área total que se 
encuentra sembrada con el cultivo.  
 
Number of Staggering Blocks: número de bloques de siembra, si se selecciona 1 significa que 
todo el cultivo será sembrado en la misma fecha de siembra en un solo bloque; si se selecciona 
2 sembraremos el cultivo en dos bloques: el primero según la fecha de siembra introducida 
como First Planting y la segunda unos días después de sembrada la primera (este número de 
días se introduce en la celda “Time interval; Between Planting of Blocks” que se activará al 
colocar el numero 2 mencionado). 
 
En nuestro caso sembraremos el cultivo en un solo bloque el día 20 de Mayo. Sembraremos 
toda la finca con ese cultivo (100 % del área). En nuestro caso debemos introducir como Crop 
Data File al archivo creado en el primer paso caraota.cro.  Por lo tanto:  
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Finalmente damos clic a “Save” y le damos como nombre caraota.cpt 
 
 
5. Datos del Suelo 
 
Antes de introducir los datos del suelo, debemos calcular la lámina almacenable por metro de 
profundidad utilizando la siguiente ecuación: 
 

1000Da
100

PMPCCLa(mm/m) ∗∗
−

=  

 
donde La = lámina almacenable (mm/m); CC = capacidad de campo (%); PMP = punto de 
marchitez permanente (%); Da = densidad aparente (gr/cm3). 
 
En nuestro caso tenemos el siguiente resultado: 
 

mm/m14310003.1
100

3142La(mm/m) =∗∗
−

=  

 
a) El próximo paso consiste en introducir los datos del suelo. En el menú principal 

seleccionamos InputData > Soil > Enter/Modify.  Se abre la ventana de entrada de datos 
del suelo (Monthly Rainfall Data). 
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-  Se abre la ventana de “Soil Data” 
 

 
 
 
Soil Description: descripción del suelo; Total Available Soil Moisture : lámina almacenable 
total en mm/m; Maximum Rain Infiltration Rate: tasa de infiltración máxima del suelo. 
 
Initial Soil Moisture Depletion: Agotamiento Inicial de humedad en el suelo. Si el suelo se 
encuentra a capacidad de campo, el agotamiento es de 0 %; si el suelo esta seco el agotamiento 
es de 100%; 
 
Initial Available Soil Moisture: Humedad disponible inicial en el suelo en mm/m    
 
En nuestro caso tenemos un suelo franco, con una infiltración básica de 40 mm/día, una lámina 
almacenable de 143 mm/m. Consideremos además que el suelo se encuentra a capacidad de 
campo para el inicio del calendario de riego. 
 
 

 
 
 
 
Finalmente demos clic a “Save” y guardemos el archivo como franco.soi 
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6.  DEFINICION DE LOS CRITERIOS PARA EL CALENDARIO DE RIEGO 
 
Ahora necesitamos introducir los criterios para la definición del calendario de riego. En el 
menú principal seleccionamos Schedule > Criteria.  Se abre la ventana de los criterios para el 
calendario de riego (Scheduling) en la ventana de “Calculation Methods”: 
. 
 

 
 

 
 
 
 

Todas las opciones fueron explicadas anteriormente en el manual. En nuestro caso 
seleccionemos lo siguiente: 
 

1. En “Application Timing” (momento de aplicación) seleccionemos aplicar el agua con 
una frecuencia fija de 7 dias  (fixed interval = 7 days). 

2. En “Application Depth” (Lámina de agua aplicar) seleccionemos que vamos a llevar 
siempre el suelo a capacidad de campo (Refill to a Specified % of Readily Available 
Water = 100 %) 

3. Para el comienzo del calendario (Start of Scheduling) seleccionemos el primer día de 
siembra de cada cultivo (First Planting Date of Each Crop). 
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En resumen nuestra ventana lucirá como: 
 

 
 
 

- salvemos nuestros criterios dando clic al botón de “Save” y guardando como 
criterio.cwg 

 
 
 

RESULTADOS 
 
 Los resultados se presentan en Tablas y gráficos entrando al menú principal o dando clic a 
los íconos correspondientes en la barra de herramientas:  
 
 
1. Datos climaticos 
 
Tables > Climate and ETo                               Graphs > Climate and ETo 
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Tables > Rainfall                                                         Graphs > Rainfall   
 

 
 
 
 Tables > CWR  

 
 
Nótese que en promedio se requieren 0.59 l/s para regar cada hectárea de caraota (ir al final de 
la columna de FWS y ver el valor entre corchetes) ; el requerimiento en la etapa de máxima 
demanda es de 0.89 l/s/ha. Estos valores de FWS toman en cuenta la eficiencia del sistema de 
riego (en este caso 70%). Todos los valores (ETo, Kc, Lluvia, Lluvia efectiva, Requerimiento 
de Riego “Irrig. Req”) corresponde al periodo de 10 días seleccionado para la representación 
de los datos (que el CROPWAT toma por defecto).  El valor de FWS es calculado como: 
 

3600*24*ays)TimeStep(d*0)iciency/10(Irrig.Eff
10000*Irrig.ReqFWS =  

 

3600*24*10*(70/100)
10000*19,92FWS = = `0,33 l/s/ha 
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Table > Irrigation Schedule 

Representa la tabla mas importante. En ella aparece el cultivo Caraota y la reducción de 
 
 
la producción debido a estrés hídrico (Yield Reduction); en nuestro caso este valor es de 0.0 %  
lo que significa que nuestro intervalo de tiempo seleccionado (7 dias) es conveniente para 
evitar estrés hídrico en el cultivo. De producirse una reducción importante en la producción 
entonces se deberá proceder a reducir la frecuencia de riego (regar más frecuentemente) o 
cambiar algún otro criterio.    
 
 

 
 

n la columna de “Net.Irrig.” se puede observar las láminas netas de riego a aplicar y en la 

osteriormente, 7 días después, el 4 de Mayo debemos aplicar una lámina neta de riego de 12.0 

a lámina total de 438.6 mm es la demanda neta; para estimar la demanda bruta (cantidad real a 
    

 
E
columna “date” las fechas correspondientes. Por ejemplo se puede observar que el día 27 de 
Abril (7 días después de la siembra, según nuestra frecuencia fija) debemos aplicar una lámina 
neta de riego de 15.3 mm. La lámina bruta de riego será 15.3 / 0.70 = 21.9 mm (reacuérdese 
que la eficiencia de riego es de 70%).   
 
P
mm.  Si seguimos viendo hasta el final de esta columna (ver figura abajo) veremos que 
debemos aplicar un total de 438.6 mm en toda el ciclo del cultivo. La ETc total es de 532.9 mm 
y la precipitación efectiva total es de 94.3 mm. 
 
L
aplicar) debemos dividir este valor entre la eficiencia del sistema de 70 % (438.6/0.70 =  
626.6 mm)    
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Graph > Irrigation Schedule 
 
 

 
 
 
Como se puede observar en ningún momento SMD > RAM lo que indica que el cultivo no es 
sometido a estrés hídrico durante su ciclo vegetativo. 
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